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Image Viewing, Organizing and Editing Software

ImageBrowser
Ver. 6.5

Instruction Manual

In this manual, IB is used for ImageBrowser.

In this manual, the windows used in the examples are from Mac OS X 10.4.

Click on the icons below on the bottom right of the screen to switch 
between pages.

 : Go to next page    : Go to previous page

 : Return to a page you had previously displayed

Click on the chapter headings on the right side of the screen to switch to 
the contents page of each chapter.

© CANON INC. 2010     CT1-7185IBME-001
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READ CAREFULLY BEFORE USING!
CANON SOFTWARE LICENSE AGREEMENT
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM 
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF 
THIS AGREEMENT.
This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]). 
IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT 
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX 
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM 
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.
In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions 
of this Agreement.
1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single 

computer. You may physically transfer the SOFTWARE from one computer to another provided 
that the SOFTWARE is used on only one computer at a time. You shall not install or use the 
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware 
configuration where the SOFTWARE is accessible to more than one CPU or to more than one 
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE, 
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, 
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART, 
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.
2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or 

copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer 
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation 
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for 
use of the SOFTWARE. No updates, fixes or support will be made available for the 
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose, 
maintain and match the hardware and software components of your computer system. Thus 
Canon does not guarantee uninterrupted service or correction of errors or that the functions or 
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED 
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the 
SOFTWARE is warranted only against defective material under normal use for a period of ninety 
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt. 
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge 
when returned by you at your expense to your point of purchase and proven to be defective 
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original 
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if 
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE 
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S 
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR 
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS 
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, 
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF 
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE 
SOFTWARE OR THE USE THEREOF.
NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS 
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT 
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF 
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.
5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until 

expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may 
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate 
without notice to you if you fail to comply with any of the terms of this Agreement and you must 
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with 
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either 
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at 
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software 
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be 
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void 
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this 
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in 
the United States of America shall be governed and construed in all respects in accordance with 
the laws and regulations of the State of New York, without reference to choice of law principles. 
The terms of this Agreement as it relates to purchases of the Software in Canada shall be 
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the 
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of 
the SOFTWARE is subject to the United States, Canada and other applicable copyright and 
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its 
affiliated corporations and third party licensors under such laws.
Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any 
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU 
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS 
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE 
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON 
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS 
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS 
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO 
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY 
AUTHORIZED OFFICER OF CANON.
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Introduction

Main Features of IB
O Download images to your computer
O Check images
O Print images
O Organize images
O Edit images

O Adjust images
O Trim images
O Insert text
O Correct red-eye
O Change image size and type

O Utilize images
O Attach an image to an e-mail
O Create wallpaper or a screen saver

O Convert images
O Change image size and type

O Play Movies
O Use your images with CANON iMAGE GATEWAY
Symbols Used
 : Selection procedure for menus that appear on the computer 

screen
[   ] : Names of items and menus, buttons, windows, etc. that appear on 

the computer screen
<  >: Camera switch name or icon, or a keyboard key name
p.** : Reference page (jump to page by clicking)

: Help : Tip

: Important information : Helpful information

Makeup of Each Chapter
Chapter 1  Basic Operation

O Starting up and quitting IB
O Downloading images to your computer
O Checking images
O Playing movies
O Printing images

Chapter 2  Advanced Operation
O Efficient checking of images
O Organizing images
O Editing images
O Editing movies
O Utilizing images
O Index printing 
O Layout printing

Chapter 3  High-Level Functions
O Checking images with high-level functions
O Organizing images with high-level functions
O Advanced image editing

Chapter 4  Preferences
O Settings for all functions

Chapter 5  Using Images on the Internet
O Using CANON iMAGE GATEWAY

Reference
O Solving problems
O Uninstalling IB
O System requirements
O Supported images
O Lists of primary window functions
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Table of Contents
Chapter 1 Basic Operation.................................. 6

Starting up IB ....................................................................7

Downloading an Image to Your Computer........................7
Downloading Images Using Your Card Reader.............8

Viewing an Image .............................................................9
View Images as Thumbnails in the Main Window .......10

Changing the Display Magnification .........................11
Enlarging and Viewing Images One at a Time ............11

Displaying an Image Across the Whole Window 
(Full View Display)....................................................12

Playing Movies.............................................................13
Rewriting Images to a Memory Card ...........................14

Printing an Image............................................................15

Quitting IB .......................................................................16

Chapter 2 Advanced Operation ........................ 17
Checking/Sorting Images................................................18

Enlarging and Checking Images One at a Time..........18
Enlarging a Specific Part of an Image ......................19

Sorting Images.............................................................19
Extracting Images You Want to Display (Filter Display) .20

Arranging Images in the Main Window.....................20
Efficiently Checking/Sorting Images ...............................21

Organizing Images ......................................................... 22
Creating a Folder for Saving Images........................... 22
Moving Images ............................................................ 23

Moving Images in Folders ........................................ 23
Changing File and Folder Names for Images.............. 24
Deleting an Image or Folder ........................................ 25
Registering Frequently-Used Folders as Favorite Folders25

Deleting Favorite Folders ......................................... 26
Editing an Image............................................................. 27

Automatic Adjustment Using IB................................... 27
Adjusting Color and Brightness ................................... 28
Trimming an Image...................................................... 29
Inserting Text into Images ........................................... 30
Adjusting Sharpness.................................................... 31
Correcting Red-Eye Automatically............................... 32

Correcting Red-Eye Manually .................................. 32
Editing Movies ................................................................ 33

Cutting Movies............................................................. 37
Utilizing Your Images...................................................... 39

Viewing Images as a Slide Show ................................ 39
Sending an Image by E-Mail ....................................... 41
Creating Wallpaper from an Image.............................. 42
Creating a Screen Saver from an Image..................... 43

Printing Multiple Images on One Sheet of Paper 
(Index Printing) ............................................................... 45

Arranging Images Freely and Printing (Layout Printing). 46
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Chapter 3 High-Level Functions....................... 47
Comparing Multiple Images ............................................48

Viewing Shooting Information for an Image....................49

Changing the Size and Type of an Image and Saving ...49

Exporting Shooting Information ......................................50

Extracting Still Images from a Movie ..............................51

Organizing Images Using High-Level Functions.............53
Setting Keywords in Images ........................................53
Entering Comments into Images .................................53
Saving Multiple Images with New File Names.............54
Classifying Images by Shot Date.................................54

Searching for Images......................................................56

Performing Advanced Editing .........................................57
Adjusting the Color of an Image in RGB......................57
Adjusting the Brightness Level ....................................58
Adjusting the Tone Curve ............................................58
Transferring Images to Other Image Editing Software 59
Merging Images to Create Panorama Images.............60

Adding Sound to Images/Playing Back...........................61
Adding Sound to Images .............................................61
Playing Back Sound.....................................................61

Chapter 4 Preferences....................................... 62
Preferences .................................................................... 63

Browser Window Settings............................................ 63
Viewer Window Settings.............................................. 64
Confirmation Dialog Box Settings................................ 64
Processing When Rotating Settings ............................ 65
Layout Print Settings ................................................... 65
Photo Print Settings..................................................... 65
Register Application Settings....................................... 65

Chapter 5 Using Images on the Internet .......... 66
Using CANON iMAGE GATEWAY ................................. 67

Membership Registration............................................. 67
Displaying the Top Page of CANON iMAGE 
GATEWAY................................................................... 67
Uploading Images in a CANON iMAGE GATEWAY 
Album .......................................................................... 68
Displaying a Registered CANON iMAGE GATEWAY 
Album .......................................................................... 68
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Reference ............................................................. 69
Troubleshooting ..............................................................70

Deleting the Software (Uninstalling) ...............................71

System Requirements ....................................................72

Supported Images ..........................................................72

About RAW Image Task .................................................72

List of Main Window Functions .......................................73
Preview Mode..............................................................73
List Mode .....................................................................74

List of Viewer Window Functions....................................75

List of Cut Movie Window Functions ..............................76

List of Photo Print Window Functions .............................77

List of Index Print Window Functions..............................78

List of Layout Print Window Functions............................79

Contents Lookup.............................................................80

Index ...............................................................................81
About This Instruction Manual ..................................83
Trademark Acknowledgments ..................................83
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Basic Operation
Starting up IB.............................................................  7
Downloading an Image to Your Computer ................  7

Downloading Images Using Your Card Reader............  8
Viewing an Image ......................................................  9

View Images as Thumbnails in the Main Window ...... 10
Changing the Display Magnification ....................... 11

Enlarging and Viewing Images One at a Time ........... 11
Displaying an Image Across the Whole Window (Full 
View Display).......................................................... 12

Playing Movies ........................................................... 13
Rewriting Images to a Memory Card .......................... 14

Printing an Image ....................................................  15
Quitting IB................................................................  16
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Starting up IB
Click the icon on the Dock.

¿ IB starts up and the main window (browser window) appears.

Click

Main window (browser window)

Downloading an Image to Your Computer
Connect the camera and computer with the cable provided and 
download the images saved on the memory card inserted in the camera.
For downloading images, start up the camera software “EOS Utility” and 
use.

1 Connect your camera and computer and turn the 
camera on.
O When IB starts up, connect the camera and your computer with the 

interface cable provided with the camera and turn the camera on.
O For detailed instructions on connecting your camera and 

computer, refer to the “EOS Utility Instruction Manual” (PDF 
electronic manual).

¿EOS Utility starts up automatically.
EOS UtilityCO
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2 Download images.

¿Downloading of images begins.
¿The downloaded images are saved in the [Pictures] folder and 

are displayed in the main window of IB.
¿The downloaded images are sorted into folders by date and 

saved.
O Click the EOS Utility [Quit] button to quit EOS Utility and turn the 

camera’s power switch to < OFF >.

Click

Using EOS Utility to download images makes it easier to organize your 
images as they are downloaded, sorted and saved into folders by date.

Advantages of using EOS Utility to download images

You can also download images to the computer using a third-party card 
reader.

1 Start up IB and then select the save destination for 
the images in the folder area at the left of the main 
window.

2 Load the memory card into the card reader.

¿Download images window appears.

Downloading Images Using Your Card Reader

ClickCO
PY
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3 Download images.

Downloading of images begins.
The downloaded images are saved in the folder selected in step 
1 and are displayed in the main window of IB.
The downloaded images are sorted into folders by date and 
saved.
Click the [Exit] button to quit Download images window.

Click

Download images window

Using IB to download images makes it easier to organize your images 
as they are downloaded, sorted and saved into folders by date.

Advantages of using IB to download images

Depending on the card reader and computer OS used, SDXC cards 
might not be correctly detected. In such a case, connect your 
camera and computer with the provided interface cable, and 
transfer the images to your computer.

Viewing an Image
Images and movies downloaded to your computer are displayed as 
thumbnail images in the main window. You can double-click a thumbnail 
to open the viewer window and display an image at a larger size or play 
a movie.

To select multiple images, click on the images while holding 
down the < > key or < shift > key on the keyboard.
You can select all images in a folder by clicking the [Selecting 
Images] button and then selecting [Select All] from the menu that 
appears.
When you have selected a movie, the first frame shot is 
displayed in the center. For playing movies, refer to p.13.

Main window

Click to select the image

Displays the images in the folder that was selected 
from the folder area on the left of the window

The clicked image is enlarged and 
displayed in the center of the window

For a list of main window functions, refer to p.73.
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of the thumbnail images.

Click the [List Mode] tab sheet.

¿The main window display changes to List Mode.

View Images as Thumbnails in the Main Window

Click

O To select multiple images, click on the images while holding 
down the < > key or < shift > key on the keyboard.

O You can select all images in a folder by clicking the [Selecting 
Images] button and then selecting [Select All] from the menu that 
appears.

Main window (List Mode)

Click to select the image Displays the images in the folder 
that was selected from the folder 
area on the left of the window

For a list of List Mode functions, refer to p.74.
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Changing the Display Magnification
You can change the display magnification of the thumbnail images 
displayed in Preview Mode (p.73) and List Mode (p.74).

Change the display magnification.

O You can also change the display magnification by clicking [ ] 
or [ ].

¿The display magnification of the images changes.

Drag left or right

1 Double-click an image to enlarge.

¿The viewer window appears.

Enlarging and Viewing Images One at a Time

Double-click
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2 Click [ ] or [ ] to switch to the image you want to 
display.

O The shooting information is displayed if you click [ ] (Show 
Shooting Information) and select [Show Shooting Information] 
from the menu that appears.

O To quit the viewer window, click [ ] on the top left of the 
window.

Viewer window

The [Show Original Image] button appears at the bottom of the window. 
Click this button to display the processed image.

When you display RAW images in the viewer window

For a list of viewer window functions, refer to p.75.

Displaying an Image Across the Whole 
Window (Full View Display)

Double-click on the image you want to display 
across the whole window.

O You can also display the image across the whole window by 
clicking [ ] (Full Screen) on the bottom of the window.

¿The image is enlarged and displayed across the whole window.

O To return to the viewer window, click on the window or press the 
< esc > key on the keyboard.

Double-click
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[ ] icon in the thumbnail image frame in the main window.

1 In the main window, double-click a movie (image 
marked with the [ ] icon).

¿A viewer window appears.

Playing Movies

Double-click

2 Click the [ ] button.

¿The movie begins to play.
O Playback stops automatically when the movie ends.
O To play the same movie again, click the [ ] button.
O You can save the currently displayed scene as a still image by 

clicking the [Save as Still Image] button.CO
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computer to a memory card and then play them back on the camera. 
Use a third-party card reader to rewrite your images or movies to a 
memory card.

1 Insert a memory card that has been formatted on the 
camera into the card reader.

2 Select the image or movie you want to rewrite.

Rewriting Images to a Memory Card 3 Rewrite the image or movie.
O Select the [File] menu  [Rewrite Image to Memory Card].
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4 Select the destination memory card and click the 
[OK] button.

¿A confirmation window appears.

5 Click the [Transfer] button in the confirmation 
window.
¿ Image or movie exporting begins.

O You cannot rewrite MOV movies that have undergone movie 
editing (p.33) to a memory card.

O AVI movies cannot be rewritten to a memory card.

Printing an Image
This section explains how to print one image on one sheet of paper.

1 Select the image to be printed.

O To select multiple images, click on the images while holding 
down the < > key or < shift > key on the keyboard.

O You can select all images in a folder by clicking the [Selecting 
Images] button and then selecting [Select All] from the menu that 
appears.

2 Display the print settings window.
O Click the [Print & Email] button and then select [Photo Print] from 

the menu that appears.

¿The [Photo Print] window appears.

Click
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3 Set the paper size and other settings, and then click 
the [Print] button.

¿Printing begins.

Photo Print window

For a list of photo print window functions, refer to p.77.

Quitting IB
In the main window, select the [ImageBrowser] menu 

 [Quit ImageBrowser].

¿ IB quits.
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Advanced Operation
Checking/Sorting Images ......................................... 18

Enlarging and Checking Images One at a Time........  18
Enlarging a Specific Part of an Image ...................  19

Sorting Images...........................................................  19
Extracting Images You Want to Display (Filter 
Display) ..............................................................  20

Arranging Images in the Main Window ..................  20
Efficiently Checking/Sorting Images......................... 21
Organizing Images ................................................... 22

Creating a Folder for Saving Images.........................  22
Moving Images ..........................................................  23

Moving Images in Folders......................................  23
Changing File and Folder Names for Images ............  24
Deleting an Image or Folder ......................................  25
Registering Frequently-Used Folders as Favorite 
Folders ....................................................................  25

Deleting Favorite Folders.......................................  26
Editing an Image ...................................................... 27

Automatic Adjustment Using IB .................................  27
Adjusting Color and Brightness .................................  28
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Cutting Movies............................................................ 37
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Viewing Images as a Slide Show ............................... 39
Sending an Image by E-Mail ...................................... 41
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Checking/Sorting Images
You can enlarge images one at a time from a list in the main window and 
check what they look like in detail, and sort them into one of three 
groups with [ ] (ratings).

1 Double-click on the image on the top left of the main 
window.

¿The viewer window appears.

Enlarging and Checking Images One at a Time

Double-click

2 Click [ ] or [ ] to switch to the image you want to 
display.

O The shooting information is displayed if you click [ ] (Show 
Shooting Information) and select [Show Shooting Information] 
from the menu that appears.

O To quit the viewer window, click [ ] on the top left of the 
window.

O When checking RAW images, always click on the [Show Original 
Image] button and check the processed images.

Viewer window

Select multiple images in the main window (p.10) and then click on 
[ ] (View Image) (p.74) on the bottom of the main window to display 
only the selected images in the viewer window.

To display only selected images in the viewer window

For a list of viewer window functions, refer to p.75.
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Enlarging a Specific Part of an Image

1 Enlarge an image.
O Click the list box and then select the display magnification.

¿The image enlarges and the navigator window appears.

2 Display the part of the image you want to check.
O Drag the enlargement display position in the navigator window 

and display the part of the image you want to check.

O To return to full view, select [Fit to window] from the list box.

Navigator window

Enlargement 
display position
Drag to move the 
display position

Display magnification

RAW images cannot be enlarged before they are processed. By clicking 
the [Show Original Image] button on the bottom of the window, the 
image is processed and it can be enlarged.

Enlarging RAW images

You can sort images into one of three groups by attaching [ ] (ratings) 
according to photo subject or theme. Please note that [ ] is 
automatically attached to images shot with your camera.

Increase or decrease a rating.
O Click the list box and then select the number of [ ].

Sorting Images
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Extracting Images You Want to Display (Filter Display)
You can extract images displayed in the main window by the number of 
[ ] you have attached to them (ratings).

1 Click the [ ] button.

¿The extract function appears.

2 Checkmark the number of [ ] you want to extract 
and display.

¿Only the images with the number of [ ] you have checkmarked 
are displayed in the main window.

O To quit the extract display, click the [ ] button 
again.

Arranging Images in the Main Window
You can arrange images in the order of file size or shot date and time.

Select the [View] menu  [Sort]  desired item.

¿The images are arranged in the order according to the selected 
item.

Sort item Description
File Name Image file names are arranged in the order of 0 – 9  a – z.
File Modification 
Date

Images are arranged in the order of most recently 
updated.

File Size Images are arranged in the order of the smallest file size.
Shooting 
Date/Time

Images are arranged in the order of most recently shot.

Type Images are arranged in the order of BMP images  RAW 
images  JPEG images  MOV movies  PICT images 

 TIFF images.

Ascending Images are arranged from top to bottom in order of 
sorting criteria.

Descending Images are arranged from bottom to top in order of 
sorting criteria.
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Efficiently Checking/Sorting Images
With Preview Mode that displays images as thumbnails and as single 
images in the same window, you can sort images by the number of [ ] 
while checking efficiently. You can also simultaneously check shooting 
information for images.

1 Enable Preview Mode.

¿The main window display switches to Preview Mode.
Click

2 Click on a thumbnail image to switch to the image 
you want to check, and then sort with the number of 
[ ].

O When checking RAW images, always click on the [Show Original 
Image] button in the viewer window and check the processed 
images.

O When you have selected a movie, the first frame shot is 
displayed in the center. For playing movies, refer to p.13.

Preview Mode

Thumbnail image display area

The selected image in the thumbnail 
image display area is enlarged in 
the center of the window

Select the number of [ ] from the list

For a list of Preview Mode functions, refer to p.73.
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Organizing Images
This section explains functions that are useful for organizing images 
such as creating new folders for saving sorted images, moving and 
copying images and deleting unwanted images.

You can create a folder to save sorted images.

1 In the folder area, select the location where the new 
folder is to be created.

Creating a Folder for Saving Images

2 Select the [File] menu  [New Folder].

¿The [New Folder] window appears.

3 Enter a folder name and click the [OK] button.
¿The new folder is created in the folder selected in step 1.
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according to shot date or theme.

Drag the image to be moved or copied.
O To move:Drag the image and release when the image is in the 

destination folder.
O To copy: Drag the image while holding down the < option > key 

and release when the image is in the destination folder.

¿The image is moved or copied to the folder it was dragged to.

Moving Images Moving Images in Folders
You can move or copy folders that contain images, and organize images 
in folders.

Drag the folder to be moved or copied.
O To move:Drag the folder and release when the folder is in the 

destination folder.
O To copy: Drag the folder while holding down the < option > key 

and release when the folder is in the destination folder.

¿The folder is moved or copied to the folder it was dragged to.
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you want to change, or, in the folder area, select the 
folder whose name you want to change.

2 Select the [File] menu  [Rename].

¿The [Rename] window appears.

Changing File and Folder Names for Images 3 Enter the file or folder name of the image and then 
click the [OK] button.

¿The file or folder name changes to the new one.

Rename window

O You can also change the file name in the [File Information] 
window (p.49) or in the information display area (p.73) in Preview 
Mode.

O You can also change the folder name in the [File Information] 
window (p.49).
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deleting folders as all the images inside a folder will also be deleted.

1 In the main window, select the image you want to 
delete, or in the folder area, select the folder you 
want to delete.

2 Click [Send to Trash].

¿The image or folder is moved to the [Trash] and is deleted from 
IB.

O If the [Move to Trash?] dialog box appears, click the [Yes] button.
O To delete an image or a folder from your computer, on the 

desktop, select the [Finder] menu  [Empty Trash].

Deleting an Image or Folder
You can register shortcuts for frequently-used folders in the [Favorite 
Folders] tab sheet in the folder area to make images easier to find.
Please note that because the [Pictures] folder is registered as a favorite 
folder by default, the folder icon appears as [ ].

1 Select the folder you want to register.

2 Click the [Add to Favorites] button.
¿The folder icon changes to [ ] and the folder is registered as a 

favorite folder.

Registering Frequently-Used Folders as Favorite Folders

CO
PY



26

1Basic 
Operation

Reference

Introduction

2Advanced 
Operation

4
5Using the

Internet

3High-Level 
Functions

Index

Contents 
Lookup

Preferences

Table of 
Contents

3 Select the [Favorite Folders] tab sheet.

4 Select the registered folder to display the images 
inside the folder.

¿The images inside the folder appear.

Click

Any changes done to images inside registered folders will be applied to 
the original images. Therefore, please be aware that by editing or 
deleting images inside registered folders, you are in fact editing or 
deleting the original images.

If you have edited or deleted images in folders you have 
registered as favorites

Deleting Favorite Folders
If you no longer need a folder you have registered in the [Favorite 
Folders] tab sheet, you can delete it from this tab sheet.
Please note that as registered folders are shortcuts, the original folder 
will not be deleted when you delete the shortcut.

In the [Favorite Folders] tab sheet, select the folder 
you want to delete and then click the [Remove] 
button.

¿The folder is deleted.
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Editing an Image
If the brightness or color of images is different from what you visualized 
when you shot the photo, you can adjust an image using the editing 
functions to bring them closer to what you visualized.
This section explains about automatic adjustment of images, adjustment 
of brightness/saturation, trimming images, inserting text into images, 
adjustment of sharpness, red-eye correction, and cutting movies.
JPEG images deteriorate slightly when edited and saved, and the image 
before editing cannot be recovered. For this reason, an edited JPEG 
image should be saved as a separate image from the original image.
Chapter 3 explains about high-level editing functions other than those 
described above.

The brightness and colors, etc. of the image are automatically adjusted.

You can edit RAW images in Digital Photo Professional (hereinafter, 
“DPP”). Select the RAW image in the Main Window and select the 
[File] menu  [Process RAW Images by Digital Photo Professional], 
which will start up DPP. For detailed instructions on using DPP, refer 
to “Digital Photo Professional Instruction Manual” (PDF electronic 
manual).

1 Display the image to edit in the viewer window (p.18).

2 Click [Edit] and then select [Auto Adjustment] in the 
menu that appears.

¿The [Auto Adjustment] window appears.

Automatic Adjustment Using IB

3 Click the [Auto Adjust Image] button.

¿The image is adjusted.

4 Check the adjustments.

5 Click the [OK] button.
¿The [Auto Adjustment] window closes.

Auto Adjustment window

Checkmark to display the image before adjustments
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6 Save as a separate image.
O In the viewer window, click [Save].

¿The save dialog box appears.

7 Enter a new name, specify the save location and then 
click the [Save] button.

¿The edited image is saved as a separate image from the original 
image.

Enter the new name Specify the save location

You can adjust the brightness and color (saturation) of images.

1 Display the image to edit in the viewer window (p.18).

2 Click [Edit] and then select [Color/Brightness 
Adjustment] in the menu that appears (p.27).
¿The [Color/Brightness Adjustment] window appears.

3 Select the [Color Adjustment] tab sheet and adjust 
the image. 

O Move the slider to the right to make the [Saturation] of an image 
to appear more vivid and the [Brightness] appear brighter. Move 
the slider to the left to make the [Saturation] of an image weaker, 
and the [Brightness] of an image appears darker.

¿The image is adjusted.

4 Check the adjustments and then click the [OK] 
button.

5 Save the image as a separate image (Description on the 
left).

Adjusting Color and Brightness

Color/Brightness Adjustment window

Drag to the left or right to adjust

CO
PY



29

1Basic 
Operation

Reference

Introduction

2Advanced 
Operation

4
5Using the

Internet

3High-Level 
Functions

Index

Contents 
Lookup

Preferences

Table of 
ContentsYou can trim only the part of an image you need, or change the 

composition of an image where an image shot horizontally becomes 
vertical.

1 Display the image to edit in the viewer window (p.18).

2 Click [Edit] and then select [Trim Image] in the menu 
that appears (p.27).
¿The [Trim Image] window appears.

3 Drag the trimming range.

O The trimming range can be moved by dragging.
O You can change the trimming range by dragging the four corners 

and the four sides of the trimming range.

Trimming an Image

Trim Image window

Drag

4 Click the [Trim Image] button.

¿The image is trimmed.

5 Check the trimming and then click the [OK] button. 

6 Save the image as a separate image (p.28).
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image as text.

1 Display the image to edit in the viewer window (p.18).

2 Click [Edit] and then select [Insert Text] in the menu 
that appears (p.27).
¿The [Insert Text] window appears.

3 Drag the range for inserting text.

O The text insertion range can be moved by dragging.
O You can change the text insertion range by dragging the four 

corners and the four sides of the text insertion range.

Inserting Text into Images

Insert Text window

Drag

4 Using the keyboard, enter the text you want to insert.

¿The text you enter appears in the window.

5 Check your entry and then click the [OK] button.

6 Save the image as a separate image (p.28).
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1 Display the image to edit in the viewer window (p.18).

2 Click [Edit] and then select [Sharpness] in the menu 
that appears (p.27).
¿The [Sharpness] window appears.

3 Adjust the image.

O Move the slider to the right to make an image harder and to the 
left to make an image softer.

¿The image is adjusted.

Adjusting Sharpness

Sharpness window

Drag right to adjust

4 Check the adjustments and then click the [OK] 
button.

5 Save the image as a separate image (p.28).
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photograph people using a flash.

1 Display the image to edit in the viewer window (p.18).

2 Click [Edit] and then select [Red Eye Correction] in 
the menu that appears (p.27).
¿The [Red Eye Correction] window appears.

3 Click the [Start] button.

¿The image is corrected.

4 Check the corrections and then click the [OK] 
button.

5 Save the image as a separate image (p.28).

Correcting Red-Eye Automatically

Red Eye Correction window

Correcting Red-Eye Manually
You can manually correct red-eye that cannot be corrected 
automatically.

1 Display the [Red Eye Correction] window (Description 
on the left).

2 Display the image enlarged and then select [Manual 
Mode].

Display the image enlargedCO
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3 Click on the places in the image you want to correct.
When you move the mouse cursor on the places to be corrected, 
[ ] is displayed.

The image is corrected.

4 Check the corrections and then click the [OK] 
button.

5 Save the image as a separate image (p.28).

Click

You can edit the movies you have downloaded to your computer in a 
number of ways, including joining movies together and adding special 
effects such as titles and background music. 

When editing 1920 x 1080 MOV movies with a function other than 
“Cutting Movies” (p.37), a temporary file is created for editing and it 
may take some time before you can start editing.  
Once you have edited movies using these functions, you cannot 
play them back on the camera.
You cannot edit MOV movies on a computer with a PowerPC 
CPU.

1 Select the movie.

There is a limit on the number of files when you are editing MOV 
movies. When you edit 1920 x 1080 MOV movies and save them in 
the same image type (format)/size, keep the number of files within 
20 files. Similarly, for 1280 x 720 and 640 x 480 MOV movies, keep 
it around 25 files.

Editing Movies
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2 Select the [Edit] menu   [Movie Edit].

¿The movie editing window appears.

3 Click the tab to select an editing task, and then edit 
the movie.

GuidanceSelect the editing task

Movie icon

Storyboard area*

* Selected movies are shown as thumbnails. Movies are joined
   together sequentially starting from the leftmost movie.

Enlarges/reduces movie 
thumbnails

Shows detailed instructions
Transition box (icon for the special effect used in 
the transition between joined movies)CO

PY
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O [Arrange] tab sheet functions

Remove the selected 
movie from the storyboard 
area

Set the playback range for the movie (playback start and end)*

* When a still image is selected in the storyboard area, you can
  select the display period for the still image.

Play movies
Set rotation or mirroring for the selected movie

Rearrange the order of the selected movies

Adds movies to the 
storyboard area

Show information for the selected movie

When you add to the storyboard area an image with recorded audio 
that has been shot with a EOS-1D series camera, the audio is not 
automatically attached. Add the audio file in the [Audio] tab sheet on 
the next page.

O [Effect] tab sheet functions

Convert the selected movie to sepia tone or monochrome

* Select the transition box in the storyboard area and then click
   [Transition] to set the effect used.

Set the effect used in the transition 
between movies (transition box)*

Add text to the selected 
movie

Enlarge part of the selected movie
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[Audio] tab sheet functions

4 Click the [Save] tab sheet.

The [Save] tab sheet appears.

Adjust the audio volume for the selected movie and set 
“Fade-in” (gradually increasing volume) and “Fade-out” 
(gradually decreasing volume)

* You can add an MP3, AIFF or WAV audio file as background music 
(BGM) or as an effects tone. When you add audio to a movie in this 
window, a bar showing the duration of the audio file appears under 
the movie’s thumbnail in the storyboard area. 

Add an audio file to the selected movie* 5 Click [Save] and specify the required settings 
(destination, etc.) in the window that appears. Then 
click [Save].

When an image type is selected in the [Specify a save image 
type] list box, clicking the [Advanced Settings] button allows you 
to specify the [Image Size], [Frame per Second]* and [Quality] 
(sound quality) settings.  The [Quality] (sound quality) sampling 
frequency for edited MOV movies is fixed at 48 kHz. 
* Frame rate : number of frames recorded per second
The edited movie is saved.

6 Select the [MovieEdit Task] menu  [Quit MovieEdit 
Task].

Set the format of the saved movie
Automatically set the optimal size and frame rate for saved 
movies
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1 Double-click the movie you want to play.

The viewer window appears.

Cutting Movies

Double-click

If you convert the frame rate of a movie after editing, some scenes 
may not playback smoothly.

When [MOV (H.264)] is selected in the [Specify a save image 
type] list box in the window in step 5, the movie durations that can 
be saved are as shown below.

If you attempt to save a movie that is longer than the times shown 
above, a message appears. When this happens, shorten the 
movie or reduce the image size.
* The frame rates 29.97 fps and 59.94 fps are respectively 

displayed as 30 fps and 60 fps in the camera menu.
Saving movies may take some time. Saving movies takes a 
particularly long time when [MOV (H.264)] is selected in the 
[Specify a save image type] list box.
E.g.) Saving a 1-minute movie with an image size of 1920 × 1080 

takes about 7 minutes depending on the system 
requirements (p.72).
Time taken to save varies largely with factors including 
computer performance and image size, and may take an 
even longer time.

Image size
Movie durations that can be saved

25 fps / 29.97 fps* 50 fps / 59.94 fps*

1920 × 1080 Under 10 min. –

1280 × 720 Under 20 min. Under 10 min.

640 × 480 Under 30 min. Under 20 min.

320 × 240 Under 60 min. –
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2 Click the [Cut Movie] button.

¿The [Cut Movie] window appears.

3 Click the [ ] button.

¿The movie begins to play.

4 Drag [ ] at the position you want to set as the start 
point, and drag [ ] at the position you want to set 
as the end point.
¿The movie is cut.

Cut Movie window
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5 Click the [Save] button.

¿The save dialog box appears.

6 Specify the file name and save destination and then 
click the [Save] button.

¿The cut movie is saved as a separate movie from the original 
movie.

Utilizing Your Images
You can view your images as a slide show, send them in an e-mail or 
use them as wallpaper or screen savers for your computer.

You can display selected images in full screen and switch between them 
as a slide show.

1 Select images.

2 Select the [View] menu  [Slide Show Options].

¿The [Slide Show Options] window appears.

Viewing Images as a Slide Show
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3 Set the play method and transition effect for the slide 
show and then click the [OK] button.

The [Slide Show Options] window closes. 

4 Click [SlideShow].

The Slide Show window appears and the slide show begins.

Slide Show Options window

*1 The image is selected. When the slide show ends and returns to 
the main window, the image is displayed as being selected.

*2 The image is selected for printing. When the slide show ends and 
returns to the main window, the print dialog box is displayed.
When all the images have been displayed, the Slide Show 
window closes and returns to the main window.
To end the slide show half-way through, click [ ].

Slide Show window

Rating setting
Selects the image*1

Prints the image*2

Switches to the first image
Switches to the previous image

Ends the slide show
Switches to the last 
image
Switches to the next 
image
Pauses the slide 
show
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The attached image to be sent is a copy of the original image and 
therefore the original image remains unaffected on your computer.

1 Select an image.

2 Click [Print & Email] and then select [Create Image 
for Email] in the menu that appears.

¿The [Create Image for Email] window appears.

Sending an Image by E-Mail 3 Select [Using the recommended settings.] and then 
click the [Finish] button.

¿The image is displayed in the main window and the e-mail 
software starts up.

O Attach to the e-mail [Email Images] in the folder area and then 
send the e-mail.

Create Image for Email window
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The JPEG image for the wallpaper (extension “.JPG”) is created using a 
copy of an image and therefore the original image remains unaffected.

1 Select an image.

2 Select the [File] menu  [Export Image].

¿The [Write a still image] window appears.

Creating Wallpaper from an Image 3 Select [Export an Image as Wallpaper] and then click 
the [Next] button.

¿The [Set Image as Wallpaper] window appears.

4 From the list box, select the wallpaper display 
method and then click the [Finish] button.

¿The image you selected for your wallpaper is applied as 
wallpaper.

Write a still image window

Set Image as Wallpaper window
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click [Desktop & Screen Saver].
2 Select the [Desktop] tab sheet. 
3 Select the file for the wallpaper and then click [ ] to close the dialog 

box.

To revert to the original wallpaper

You can make a selected image a screen saver for your computer.
The data for the screen saver (extension “.SLIDESAVER”) is created 
using a copy of an image and therefore the original image remains 
unaffected.

1 Select an image.

2 Select the [File] menu  [Export Image].

¿The [Write a still image] window appears.

Creating a Screen Saver from an Image
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3 Select [Export as a Screensaver] and then click the 
[Next] button.
¿The [Export as a Screensaver] window appears. 

4 Using the keyboard, enter a name and then click the 
[Finish] button.

O The screen saver data is saved in the [Screen Savers] folder.

Export as a Screensaver window

5 Specify the saved screen saver on your computer.
O On the desktop, launch [System Preferences] from the Dock and 

then click [Desktop & Screen Saver]  [Screen Saver] tab sheet 
to display the [Screen Saver] tab sheet. 

6 Close the [Desktop & Screen Saver] window.
O Click [ ] on the top left of the dialog box.

Select the saved screen saver dataCO
PY
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Printing Multiple Images on One Sheet of Paper (Index Printing)
You can arrange multiple images in index format and print them on one 
sheet of paper.

1 Select the images.

2 Click the [Print & Email] button and then select 
[Index Print] from the menu that appears.

¿The [Index Print] window appears.

3 Specify settings such as the paper type and the 
number of prints, and then click the [Print] button.

¿Printing begins.
Print preview

Index Print window

For a list of index print window functions, refer to p.78.
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Arranging Images Freely and Printing (Layout Printing)
You can lay out images freely and then print them.

1 Select the images.

2 Click the [Print & Email] button and then select 
[Layout Print] from the menu that appears. 

¿The [Layout Print] window appears.

3 Lay out your images by dragging them and then click 
the [Print] button.

¿Printing begins.

Print preview

Layout Print window

For a list of layout print window functions, refer to p.79.
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Comparing Multiple Images
To compare multiple images, you can split the viewer window into two, 
three or four and display multiple images at the same time.
You can also align the display position of enlarged images and compare.

1 In the main window, select the images you want to 
compare (p.10).

2 Click [ ] (View Image) (p.74).
¿The viewer window appears.

3 Click [Number of Displays] and select the number of 
images you want to display at the same time.

¿The viewer window is split and the multiple images are displayed 
at the same time.

Example of display when [4-Page View] is selected

4 Click [Synchronize] and then enlarge the image.

¿The synchronize display appears and all the images are displayed 
at the same display magnification and in the same position.

¿The navigator window that displays the enlargement display 
position appears and you can check and move the enlargement 
display position (p.19).

O Click [Synchronize] again to cancel the synchronize display. You 
can now change the display magnification and move the 
enlargement display position for each image.

O To return to full view, select [Fit to window] from the list box under 
each image.

O To cancel the split display, click [Number of Displays] at the bottom of 
the window and then select [Single View] from the menu that appears. 

Click Select the display magnification
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Viewing Shooting Information for an Image
1 Display List Mode (p.74).

2 Select the image for which you want to view the 
information.

3 Select the [File] menu  [Get Info].
¿The [File Information] window appears. 

4 Click the [Advanced View] button.

In Preview Mode, the same information as the [File Information] 
window is displayed on the information display area (p.73).

Changing the Size and Type of an Image and Saving
You can change the size of an image or convert it to a TIFF image 
(extension “.TIFF”) or a PICT image (extension “.PCT”) and save it. 
Because the image is saved as a separate image, the original image 
remains unaffected.

1 Select an image.

2 Select the [File] menu  [Export Image].
¿The [Write a still image] window appears.

3 Select [Edit and Save Image] and then click the 
[Next] button.

¿The [Edit and Save Image] window appears.
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4 Specify the image size, type, file name and save 
destination, and then click the [Finish] button.

¿The image is saved as an image separate from the original 
image.

Exporting Shooting Information
You can export as a text file the shooting information recorded to the 
image.

1 Select an image.

2 Select the [File] menu  [Export Image].
¿The [Write a still image] window appears.

3 Select [Export Shooting Properties] and then click 
the [Next] button. 
¿The [Export Shooting Properties] window appears.

4 Specify the export shooting information, the file 
name, and the save destination, and then click the 
[Finish] button.

¿The shooting information is saved as a text file (extension 
“.TXT”).
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Extracting Still Images from a Movie
You can extract still images from a movie and save them as image files.

O When extracting still images from 1920 x 1080 MOV movies, a 
temporary file is created for editing and it may take some time 
before you can extract still images.

1 Select the movie.

2 Select the [Edit] menu  [Extract frames from a movie].

¿The [Settings] tab sheet for [MovieFrame Task] appears.

3 Set the extraction method and click the [Preview] tab 
sheet.

O [Extract all frames]
This option extracts all the frames in a movie as still images.

O [Specify an interval and extract frames]
This option extracts still images from a movie at intervals of a set 
number of frames or seconds.

O [Specify the number of copies and extract frames]
This option extracts a specified number of still images from the 
frames of a movie. The interval at which each of the specified 
number of images is extracted is calculated evenly across the 
movie's number of frames.

O [Extract a specified image]
This option extracts a still image of a scene of your choice during 
movie playback.

¿The [Preview] tab sheet appears.
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4 Check the extracted images and click the [Save] tab 
sheet.
O When [Extract a specified image] is selected in step 3, you can 

play the movie on the left of the window and extract an image by 
clicking [ ] when you reach a scene you like.

¿The [Save] tab sheet appears.

Remove the check mark from the images 
before and after the selected image

Resize the thumbnails

Playback/pause, frame back, 
frame forward, half-speed 
playback, double-speed playback

Save the images with 
check marks

Add/remove all the check marks
Rotate all the images

5 Click [Save] and specify the required settings 
(destination, etc.) in the window that appears. Then 
click [Choose].

¿Still image extraction begins.

6 Select the [MovieFrame Task] menu  [Quit 
MovieFrame Task].CO
PY
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Organizing Images Using High-Level Functions
You can organize images using high-level functions such as setting 
keywords and entering comments, renaming multiple files in a single 
operation and classifying images by shot year/month/date, all of which 
are useful when organizing your images.

You can set keywords to identify images. The set keywords are also 
useful when searching for images (p.56).

1 Select an image.

2 Select the [Edit] menu  [Keyword]  [Settings].
¿The [Keywords Setting] window appears.

3 Select the keyword(s) and then click the [OK] button.

¿The keyword is set in the image.

Setting Keywords in Images

You can enter information relating to images as comments. The entered 
comments are also useful when searching for images (p.56).

1 Display the [File Information] window (p.49).

2 Click the [Advanced View] button.
¿A field for entering comments is displayed.

3 Enter text and then press the < return > key on the 
keyboard.

¿The entered text is saved in the image.

Entering Comments into Images
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single operation.

1 Select all the images you want to save with new file 
names (p.10).

2 Select the [File] menu  [Organize Image]  
[Rename].
¿The [Rename] window appears.

3 Enter the file name and click the [OK] button. 

¿ Images separate from the original images are saved with the new 
names.

Saving Multiple Images with New File Names
Multiple images can be classified into different folders according to shot 
date.

1 Select all the images to be classified (p.10).

2 Select the [File] menu  [Organize Image]  [Sort 
Images].
¿The [Sort Images] window appears.

3 Select [The files will be separated into folders for 
each shooting date.] and then click the [Next] button.

¿The [Organize by Shooting Date] window appears.

Classifying Images by Shot Date
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4 Specify the folder structure, the file names, and the 
save destination, and then click the [OK] button.

¿ Images are classified by shot date.

Settings for Folder Structure
Setting Item Description

YearMonthDate Classifies images by creating a first-level folder 
according to shot year/month/date.

Year/YearMonthDate Classifies images by creating a second-level 
folder for the shot year, and the month and date.

Year/Month/
YearMonthDate

Classifies images by creating a third-level folder 
for the shot year, the month, and the date.

Year/NewName Classifies images by creating a new folder with a 
new name inside the shot year folders.

NewName/
YearMonthDate

Classifies images by creating folders for shot 
year/month/date inside a folder with a new name.

YearMonthDate/
NewName

Classifies images by creating a new folder with a 
new name inside the shot year/month/date 
folders. 
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Searching for Images
You can search for images by ratings (p.19), shot date, comments (p.53) 
and keywords (p.53).

1 Select the [File] menu  [Search].
¿The [Set Search Criteria] window appears.

2 Specify the search criteria and then click the [Search 
Now] button.

¿The search begins and the images that match the criteria are 
displayed in the [Search Results] window. 

3 Click the [Finish] button to close the [Search 
Results] window.
¿The display returns to the main window.

4 Check the searched images in the main window.
O The searched images are displayed in the main window. Also, 

the [Search Results] folder is displayed in the folder area, and by 
selecting this folder, you can display the searched images at any 
time.

O The images inside the [Search Results] folder are stored until 
you either perform another search or quit IB.

O Any work you do on images inside the [Search Results] folder will 
be applied to all the original images. Therefore, please be aware 
that if you edit or delete images inside the [Search Results] 
folders, the original images will be edited or deleted also.
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Performing Advanced Editing
This section explains image editing using high-level functions based on 
the assumption that you are familiar with handling standard image 
editing software.
JPEG images deteriorate slightly when edited and saved, and the image 
before editing cannot be recovered. For this reason, an edited JPEG 
image should be saved as a separate image from the original image.

You can adjust the color of an image in RGB (red, green, blue).

You can edit RAW images in Digital Photo Professional (hereinafter, 
“DPP”). Select the RAW image in the Main Window and select the 
[File] menu  [Process RAW Images by Digital Photo Professional], 
which will start up DPP. For detailed instructions on using DPP, refer 
to “Digital Photo Professional Instruction Manual” (PDF electronic 
manual).

1 Display the image to edit in the viewer window (p.18).

2 Click [Edit] and then select [Color/Brightness 
Adjustment] in the menu that appears (p.27).
¿The [Color/Brightness Adjustment] window appears.

Adjusting the Color of an Image in RGB

3 Select the [RGB Adjustment] tab sheet and adjust 
the image. 

¿The image is adjusted.

4 Check the adjustments and then click the [OK] 
button.

5 Save the image as a separate image (p.28).

Drag to the left or right to adjust
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1 Display the image to edit in the viewer window (p.18).

2 Click [Edit] and then select [Level Adjustment] in the 
menu that appears (p.27).
¿The [Level Adjustment] window appears.

3 Adjust the image.

¿The image is adjusted.

4 Check the adjustments and then click the [OK] 
button.

5 Save as a separate image (p.28).

Adjusting the Brightness Level 

Drag to the left or right to adjust

Drag left to adjustDrag right to adjust

You can adjust the brightness, contrast and color of a specific area by 
changing the tone curve.

1 Display the image to edit in the viewer window (p.18).

2 Click [Edit] and then select [Tone Curve Adjustment] 
in the menu that appears (p.27).
¿The [Tone Curve Adjustment] window appears.

3 Adjust the image.

¿The image is adjusted.
O The horizontal axis shows the input level and the vertical axis 

shows the output level.
O The maximum number of [ ] is 10.
O To delete a [ ] , press the < delete > key on the keyboard.

Adjusting the Tone Curve

Click to add a [ ] (point)
Adjust by dragging [ ]
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4 Check the adjustments and then click the [OK] 
button.

5 Save as a separate image (p.28).
You can transfer images to image editing software other than IB.

1 In the main window, select the [ImageBrowser] menu 
 [Preferences].

¿The [Preferences] window appears.

2 From the menu, select [Register Application] and 
then click the [Add] button.
¿The [Application Selection] window appears.

3 Select the image editing software to transfer to, and 
then click the [Open] button
¿The selected software is registered.

4 Click the [OK] button and then close the 
[Preferences] window.

5 Select the image you want to transfer to the image 
editing software.

6 Select the [Edit] menu  [Edit with Registered 
Application]  image editing software to transfer to.
¿The selected image editing software starts up and then image is 

displayed.

Transferring Images to Other Image Editing Software
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For merging images, start up the image-merging software “PhotoStitch” 
from IB and use.

1 Select multiple images to merge (p.10).

2 Select the [Edit] menu  [PhotoStitch].
¿PhotoStitch starts up and the main window appears.

3 Check the arrangement of the images to be merged 
and click the [2. Merge] tab sheet.
O If the arrangement of the images to be merged is not correct, 

drag the images to rearrange them.

¿The window switches to the [2. Merge] tab sheet.

Merging Images to Create Panorama Images 4 Click [Start] to merge.

¿The images are merged and displayed.

5 Click the [3. Save] tab sheet.
¿The display switches to the [3. Save] tab sheet.
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6 Check the save range and then click [Save].

¿The [Save As] dialog box appears.

7 Specify the save destination and then click the 
[Save] button.
¿The merged images are saved.

8Select the [PhotoStitch] menu  [Quit PhotoStitch].
¿PhotoStitch quits.

Save range
Drag [ ] to change the range

See also the Help that are displayed when you click [ ] on the 
right of the window for information on operating PhotoStitch and 
PhotoStitch functions.

Adding Sound to Images/Playing Back
You can add sound to images and play back sound which you have 
added to images with a camera that has a sound record function.

You can add a sound file to an image.
A Mac OS X function is used for sound recording. When inputting sound 
from external equipment, connect the external equipment to your 
computer beforehand.

You can play back sound files that are attached to images.

1 Select an image to which you want to add sound.

2 Select the [File] menu  [Sound]  [Record].
¿The audio recording dialog box appears.

3 Click [ ] (recording button) and begin recording the 
sound to be added to the image. Click the [Save] 
button to stop recording.
¿The recorded sound file is added to the image. The [ ] icon is 

displayed in the image to which the sound file was added.

1 Select an image to which a [ ] icon is attached.

2 Select the [File] menu  [Sound]  [Play].
¿The sound is played back.

Adding Sound to Images

Playing Back SoundCO
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Preferences
You can change any of the IB functions in the preferences window. 
Check the settings displayed for each window before making changes.

1 Select the [ImageBrowser] menu  [Preferences].

2 From the menu, select the dialog box you want to 
display, specify your settings, and then click the 
[OK] button. 

You can change the background color of the main window (browser 
window) as well as the color of the thumbnail image frames. 
You can also make settings for color management.

Browser Window Settings
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(p.75).

Viewer Window Settings

In the viewer window, click the [Show Shooting Information] button 
(p.75) and in the menu that appears, select [Show Shooting Information] 
to display the shooting information. 

To display the shooting information in the viewer window

You can set the software so that confirmation dialog boxes displayed 
after each operation are not displayed.
The items you uncheck are not displayed. 

Confirmation Dialog Box Settings
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You can make settings for layout printing.

Processing When Rotating Settings

Layout Print Settings

When printing with the [Photo Print] window (p.16), you can set whether 
to trim the image and print with no borders around the paper, or to print 
as is without trimming.

You can register other editing software.

Photo Print Settings

Register Application SettingsCO
PY
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Using Images on the Internet
Using CANON iMAGE GATEWAY ..........................  67
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Using CANON iMAGE GATEWAY
CANON iMAGE GATEWAY is a free Internet online service restricted to 
users who have purchased a Canon digital camera (no membership or 
annual fee).
To connect to CANON iMAGE GATEWAY, it is necessary to register as a 
member beforehand. Insert the EOS DIGITAL Solution Disk provided 
into your computer and perform registration in the CANON iMAGE 
GATEWAY member registration window that appears after installing the 
software that includes IB. You can also use the following procedure to 
register as a member.
For detailed information on CANON iMAGE GATEWAY, refer to the 
CANON iMAGE GATEWAY Help.

You can register as a member of CANON iMAGE GATEWAY.
When you have finished registering, you can also change the 
connection information or add cameras.

1 Register as a member.
Click [CANON iMAGE GATEWAY] and in the menu that appears, 
select [Register/Add Product]. 

The [Register/Add Product] dialog box appears.

2 Click the [Register] button.
The browser software starts up and the CANON iMAGE 
GATEWAY membership registration page is displayed.
Perform membership registration by following the on-screen 
instructions.
When you have finished registering, you can also change the 
connection information or add cameras.

Membership Registration

The CANON iMAGE GATEWAY top page is displayed with the browser 
software.

1 Connect to the top page.
Click [CANON iMAGE GATEWAY] and in the menu that appears, 
select [Top Page].

The [Enter registration information.] dialog box appears.

2 Enter your user name and password and then click 
the [OK] button.

When the connection dialog box is displayed and connection is 
completed, the browser software starts up and the top page of 
CANON iMAGE GATEWAY is displayed.

Displaying the Top Page of CANON iMAGE GATEWAY
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Online photo album. You can also show images in a registered album to 
specified people.
The images uploaded in an album are copies, so the original images 
remain unaffected on your computer.

1 Select images to be uploaded in an album.

2 Connect to CANON iMAGE GATEWAY.
Click [CANON iMAGE GATEWAY] and in the menu that appears, 
select [Upload Images].

3 Upload the images selected in step 1 to a new album 
by following the on-screen instructions.

Uploading Images in a CANON iMAGE GATEWAY Album
You can display images that have been uploaded in a CANON iMAGE 
GATEWAY Online photo album with the browser software.

1 Display an album.
Click [CANON iMAGE GATEWAY] and in the menu that appears, 
select [View Online Photo Album].

The [Enter registration information.] dialog box appears.

2 Enter your user name and password and then click 
the [OK] button.

When the connection dialog box is displayed and connection is 
completed, the browser software starts up and the CANON 
iMAGE GATEWAY album page is displayed.

Displaying a Registered CANON iMAGE GATEWAY Album
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Troubleshooting
If IB is not operating correctly, refer to the items below.
Also refer to the Help from the [Help] menu or click the [?] button at the 
top of each window and refer to the Help displayed.

O You cannot install software unless you are logged into an account with 
Administrator privileges. Log in again into an account with 
Administrator privileges. 
For how to log in and how to specify Administrator settings, refer to 
the User’s Manual for the Macintosh computer or for Mac OS X.

O IB does not operate correctly on a computer if its system 
requirements does not meet. Use IB on a computer with compatible 
system requirements (p.72).

O Even if your computer has the RAM capacity (memory) described in 
the system requirements (p.72), if other applications are running at 
the same time as IB, you may not have sufficient RAM (memory). Quit 
any applications other than IB.

O The software preferences file may be corrupted. Quit all applications 
and follow the procedure below to delete the preferences file from the 
[Preferences] folder before restarting IB.
In the hard disk drive where the system is saved, open the [Users] 
folder  folder of the logged in user  [Library] folder  [Preferences] 
folder, and delete the preferences files below. 

Installation could not be completed correctly

IB does not work

Preferences Description

com.canon.ImageBrowser.plist Preferences file for the 
ImageBrowser

com.canon.RAWImageTask.plist Preferences file for the RAW 
Image Task

com.canon.PhotoStitch.plist Preferences file for the 
PhotoStitch

O Images that are not supported by IB (p.72) do not display. There are 
various types of JPEG and TIFF images, so JPEG images other than 
Exif 2.2 and 2.21 compatible images and TIFF images other than Exif 
compatible images may not display properly.

O With initial settings, the color of images that have been shot in Adobe 
RGB appear weak. In this case, check the [Browser Window] window 
in preferences and checkmark [Adjust Image Colors Using a Monitor 
Profile] (p.63). Color management is performed and the color of the 
image shot with an Adobe RGB setting and the image shot with an 
sRGB setting are matched.

Images do not display properly

CO
PY



71

1Basic 
Operation

Reference

Introduction

2Advanced 
Operation

4
5Using the

Internet

3High-Level 
Functions

Index

Contents 
Lookup

Preferences

Table of 
Contents

Deleting the Software (Uninstalling)
O Quit any applications before uninstalling the software.
O To uninstall the software, log into the account used when installation 

was performed.
O To prevent computer malfunctions, always restart your computer after 

you have uninstalled the software.

1 Display the folder in which the software is saved.
¿Open the [Canon Utilities] folder.

2 Drag the [ImageBrowser] folder to the Trash.

3 Select the [Finder] menu on the desktop  [Empty 
Trash].
¿The software is deleted.

4 Restart your computer.

O You cannot retrieve data that you have emptied into the Trash 
and deleted, so be particularly careful when deleting data.

O You cannot install the software again if you have just moved the 
[ImageBrowser] folder to the trash. Be sure to select the [Finder] 
menu  [Empty Trash]. 
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Even though the following are recommended system requirements, not 
all computer functions can be guaranteed.

This software program is not compatible with UFS (UNIX File System) 
formatted disks.

* Use a Core 2 Duo 2.6GHz or higher CPU and 2GB or more RAM 
when working with MOV movies. However, even if there is nothing 
wrong with a movie file, it may drop frame and not play smoothly 
during playback, depending on your computer specifications.

OS Mac OS X 10.4 to 10.6
Computer Macintosh with one of the above OS installed

CPU* PowerPC G4, G5 (Mac OS X 10.4 to 10.5), or Intel 
processor (Mac OS X 10.4 to 10.6)

RAM* Minimum 512MB (Mac OS X 10.4 to10.5), Minimum 1GB 
(Mac OS X 10.6)

Display Resolution : 1024 × 768 or more
Colors : Thousands or more

Supported Images

* “.THM” is a (thumbnail) file that is saved with the same file name as 
the movie and that includes shooting information.
When you play a movie with the camera, both the movie file and the 
“.THM” file are required.

About RAW Image Task
RAW Image Task is the RAW image editing software linked with IB. 
RAW Image Task is not provided with IB ver. 6.5, but if it is installed 
on your computer, it can be started up from IB ver. 6.5 in the same 
way as from versions 6.1 and earlier.
RAW Image Task is not compatible with RAW images shot with EOS-
1D Mark IV, EOS 5D Mark II, EOS 7D, EOS 50D, EOS REBEL T2i/
550D, and EOS REBEL T1i/500D.

Image type Extension

JPEG images
JPEG images shot with a Canon digital 
camera (Exif 2.2 or 2.21-compatible 
JPEG images)

.JPG, .JPEG

RAW images
RAW images shot with a EOS DIGITAL 
camera excluding EOS D6000, EOS 
D2000, EOS DCS1, EOS DCS3

.CR2
.TIF

.CRW
TIFF images Exif-compatible TIFF images .TIF, .TIFF
BMP images Bitmap images .BMP
PICT images PICT images .PICT

MOV movies MOV movies shot with a Canon digital 
camera .MOV + .THM*

AVI movies AVI movies shot with a Canon digital 
camera .AVI + .THM*

System Requirements
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Preview Mode

Shows/hides the folder area

Information display area

*1 Images in folders selected here are displayed on the thumbnail image display area.
*2 Images selected here are displayed on the image display area.

Folder area*1

Thumbnail image 
display area*2

Image display area

Shows/hides the task buttons
Shows/hides the 
information display area
Selects/deselects all the 
images
Number of selected images/
Total number of imagesDeletes images and folders (p.25)

Prints images and creates images for e-mail (p.15, p.41, p.45, p.46)
Connects to the CANON iMAGE GATEWAY

Slide show (p.40)

Viewer window (p.75)

Starts up EOS Utility/Displays 
Download images window 
(p.7, p.9)

Filter display 
(p.20)

Enlarges/
reduces the 
thumbnail 
images (p.11)

List of Main Window Functions
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List Mode

RAW image icon

* Images in folders selected here are displayed on the image display area.

Bracketing icon

Image display area

Protect icon

Audio recording icon

Shows/hides the folder area

Folder area*

Shows/hides the task buttons

Selects/deselects all the 
images
Number of selected images/
Total number of imagesDeletes images and folders (p.25)

Prints images and creates images for e-mail (p.15, p.41, p.45, p.46)
Connects to the CANON iMAGE GATEWAY

Slide show 
(p.40)

Viewer window (p.75)

Starts up EOS Utility/Displays 
Download images window 
(p.7, p.9)

Filter display 
(p.20)

Enlarges/
reduces the 
thumbnail 
images (p.11)

Movie icon
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List of Viewer Window Functions

Image display area

Rating (p.19)

Shows/hides the 
shooting information 
and AF point 
(p.12, p.18)

Display magnification

Photo print window (p.77)
Full view display (p.12)

Displayed image size

Split displays (p.48)
Edits the images (p.27)

Saves the images (p.28)

Synchronize (p.48)

Switches 
between images

Display magnification 
(p.19)
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List of Cut Movie Window Functions (p.37)

Displays the movie

Previous framePlays the movie/Stops the movie

Current position during movie play

Sets the start point for a movie cut

Next frameAdjusts volume

Sets the end point for a movie cut

Saves a cut movie as a separate movieCO
PY
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List of Photo Print Window Functions

Page settings

Shot date and 
time settings

Printer selection and settings

Print preview

Number of prints

Trims the image

Switches the printing image

Inserts text
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List of Index Print Window Functions

Print information 
settings

Printer selection 
and settings

Print preview

Rotates the imageSwitches the printing page

Trims the image

Page settings
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List of Layout Print Window Functions

Print preview

Rotates the image Deletes an image
Reverts to the original condition

Number of images per page

Trims the image

Printer selection 
and settings

Page settings

Sets the printing 
style
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Contents Lookup
Downloading Images to Your Computer
O Download images by connecting your camera and computer ¿ p.7
O Download images using a card reader ¿ p.8

Image Checking
O Look through ¿ p.10
O Enlarge and view ¿ p.11, p.18
O Play a movie ¿ p.13
O Check efficiently ¿ p.21
O Compare multiple images ¿ p.48
O Check the shooting information such as shot 

date ¿ p.49

O View as a slide show ¿ p.39

Image Printing
O Print one image on one page ¿ p.15
O Arrange multiple images on one page and print ¿ p.45
O Arrange images freely and print ¿ p.46

Organizing Images
O Sort by rating ¿ p.19
O Move to a different location ¿ p.23
O Move by entire folder to a different location ¿ p.23
O Change the file name ¿ p.24
O Delete ¿ p.25
O Classify by shot date ¿ p.54
O Search ¿ p.56

Image Editing
O Use automatic adjustment ¿ p.27
O Adjust brightness/darkness ¿ p.28
O Make colors more vivid ¿ p.28
O Trim parts of an image ¿ p.29
O Specify an aspect ratio that matches the size of 

the paper on which an image is to be printed ¿ p.29

O Make an image sharp ¿ p.31
O Insert text ¿ p.30
O Correct red-eye ¿ p.32
O Merge ¿ p.60
O Edit movies ¿ p.33
O Cut a favorite scene from a movie ¿ p.37
O Extract still images from movies ¿ p.51

Utilizing Images
O Attach an image to an e-mail ¿ p.41
O Make into computer wallpaper ¿ p.42
O Make into a computer screen saver ¿ p.43
O Use CANON iMAGE GATEWAY ¿ p.67

Converting Images
O Change the size ¿ p.49
O Convert to a different type ¿ p.49
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Index
A
Adding Sound to Images.....................................................................  61
Adjust JPEG Images.....................................................................  27, 57
Adjusting (JPEG or TIFF Image)...................................................  27, 57

Adjusting in RGB ..........................................................................  57
Adjusting the Brightness...............................................................  28
Adjusting the Brightness Level .....................................................  58
Adjusting the Saturation ...............................................................  28
Adjusting the Sharpness ..............................................................  31
Adjusting the Tone Curve.............................................................  58
Automatic Adjustment ..................................................................  27
Correcting Red-eye ......................................................................  32

Adjusting the Brightness .....................................................................  28
Adjusting the Brightness Level............................................................  58
Adjusting the Saturation......................................................................  28
Adjusting the Sharpness .....................................................................  31
Adjusting the Tone Curve ...................................................................  58
Attach an Image to an E-mail..............................................................  41
Automatic Adjustment .........................................................................  27

B
Batch Change the File Name of Images .............................................  54
Browser Window.................................................................................  82
Browser Window Settings (Preferences) ............................................  63

C
CANON iMAGE GATEWAY................................................................  67

Displaying an Album.....................................................................  68
Membership Registration .............................................................  67
Uploading Images in an Album ....................................................  68

Change File Name..............................................................................  24
Change Folder Name..........................................................................  24
Change the Display Magnification ......................................................  11
Changing the Size and Type of an Image and Saving........................  49
Checking the Shooting Information.....................................................  49
Classifying the Images by Shot Date ..................................................  54
Color Management .............................................................................  63
Compare Multiple Images ...................................................................  48

Confirmation Dialog Box Settings (Preferences) ................................. 64
Correcting Red-eye ............................................................................. 32
Creating a Folder................................................................................. 22
Cutting a Movie.................................................................................... 37

D
Delete

Delete Folders............................................................................... 25
Delete Images............................................................................... 25
Delete the Software ...................................................................... 71

Delete Folders ..................................................................................... 25
Delete Images ..................................................................................... 25
Delete the Software (Uninstalling) ....................................................... 71
Deleting the IB (Uninstalling) ............................................................... 71
Displaying Images Shot with Adobe RGB ........................................... 70
Downloading an Image to Your Computer ............................................ 7

Downloading Images from a Camera ............................................. 7
Downloading Images from a Card Reader...................................... 8

Downloading Images ............................................................................. 7
Downloading Images from a Card Reader ............................................ 8

E
Editing.................................................................................................. 81
Editing Movies ..................................................................................... 33
Enlarge Images ............................................................................. 11, 19
Entering Comments............................................................................. 53
Exporting Shooting Information ........................................................... 50
Extracting Still Images from a Movie ................................................... 51

F
Favorite Folders................................................................................... 25
Full View Display ................................................................................. 12

I
Index Printing....................................................................................... 45
Insert Text............................................................................................ 30
Inserting Text into Images ................................................................... 30

Main Window AdjustingCO
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K
Keywords Settings ..............................................................................  53

L
Layout Print Settings (Preferences) ....................................................  65
Layout Printing ....................................................................................  46
List Mode (Main Window) .............................................................  10, 74

M
Main Window (Browser Window) ..............................................  7, 73, 74
Merging Panorama Images.................................................................  60
Move or Copy Folders.........................................................................  23
Move or Copy Images.........................................................................  23

N
Navigator Window...............................................................................  19

O
Operating with EOS Utility ....................................................................  7

P
Photo Print Settings (Preferences) .....................................................  65
Photo Printing .....................................................................................  15
Playing a Movie...................................................................................  13
Playing Back Sound............................................................................  61
Preferences.........................................................................................  63

Browser Window Settings ............................................................  63
Confirmation Dialog Box Settings.................................................  64
Layout Print Settings ....................................................................  65
Photo Print Settings......................................................................  65
Processing When Rotating Settings.............................................  65
Register Application Settings .......................................................  65
Viewer Window Settings...............................................................  64

Preview Mode (Main Window) ..................................................  9, 21, 73
Printing

Index Printing ...............................................................................  45
Layout Printing .............................................................................  46
Photo Printing...............................................................................  15

Processing When Rotating Settings (Preferences).............................  65

Q
Quitting IB............................................................................................ 16

R
Ratings ................................................................................................ 19
Register Application Settings (Preferences)........................................ 65
Rewriting Images to a Memory Card ................................................... 14

S
Searching for Images .......................................................................... 56
Setting a Screen Saver........................................................................ 43
Setting a Wallpaper ............................................................................. 42
Setting an Image as a Screen Saver................................................... 43
Setting an Image as Wallpaper ........................................................... 42
Slide Show........................................................................................... 39
Starting up IB......................................................................................... 7
Supported Images ............................................................................... 72
Synchronize Display ............................................................................ 48
System Requirements ......................................................................... 72

T
Thumbnail Display (Main Window) ...................................................... 10
Transfer Images to other Image Editing Software ............................... 59
Trimming.............................................................................................. 29
Trimming an Image.............................................................................. 29

V
View an Image....................................................................................... 9
Viewer Window........................................................................ 12, 18, 75
Viewer Window Settings (Preferences) ............................................... 64
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About This Instruction Manual
O It is prohibited to reproduce, in whole or part, the contents of this 

Instruction Manual without permission.
O Canon may change without notice the software specifications and 

contents of this Instruction Manual.
O The software screens and displays printed in this Instruction Manual 

may differ slightly from the actual software.
O The content of this Instruction Manual has been reviewed thoroughly. 

However, if you should notice any errors or omissions, please contact 
a Canon Service Center.

O Please note that irrespective of the above-mentioned, Canon does 
not take responsibility for the outcome of the operation of the 
software.

Trademark Acknowledgments
O Macintosh is a trademark of Apple Inc., registered in the United 

States and other countries.
O Other names and products not mentioned above may be registered 

trademarks or trademarks of their respective companies.
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